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Your guide to creating & exporting your book 
using Adobe® InDesign®, Adobe® Photoshop® or 
QuarkXPress® 



This manual includes all of the steps necessary to create a fantastic yearbook by submitting your yearbook files 
as PDFs! PDFs eliminate many of the problems associated with delivering print-ready desktop publishing files. 
Programs such as Adobe® InDesign®, Adobe® Photoshop® and QuarkXPress® easily export documents into this 
format. 

Please read and follow the instructions very carefully to avoid delays in the delivery of your yearbooks. Previous 
experience with page layout software is highly recommended for this plan.

If you are using other versions that are not supported in this manual, please contact us at 
graphics@walterspublishing.com.

Adobe, the Adobe logo, Photoshop and InDesign are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries.
All other trademarks are the property of their respective owners.

Let’s Get StartedWelcome

INSIDE:
	 • �Step-by-step instructions for loading our PDF settings and color profiles to your hard drive!
	 • �Step-by-step instructions for creating your PDF files for submitting your book!
	 • CD containing templates and settings!
	 • DVD containing artwork and fonts!
	 • ��Color settings for more accurate color conversion!
	 • 8.5”x11” and 9”x12” templates!
	 • �Helpful Quick Tips for Adobe® InDesign® and QuarkXPress®! 



PLEASE READ  
Before STARTING YOUR 

YEARBOOK:
Yearbook page counts must be DIVISIBLE BY 4 
(e.g,. 24 or 32 pages, but not 22 or 30 pages). Total 
page count does not include cover, or inside front 
or back cover; only interior pages. SMYTH SEWN 
yearbook page counts must be DIVISIBLE BY 16.

You can DESIGN YOUR OWN CUSTOM COVER. 
Use the Custom Cover Envelope to specify your 
details and cover options. Custom covers must be 
submitted by FEBRUARY 2ND (for yearbooks 
shipping before June 30). For Fall delivery 
yearbooks (delivered by December 31), cover files 
must be submitted by AUGUST 1ST. Contact your 
yearbook representative for pricing information.

You can CHOOSE A STOCK COVER and print your 
title in the color shown for FREE. See the Stock 
Cover Guide for choices. Stock cover art cannot be 
altered.

You can ADD STOCK AUTOGRAPH PAGES (extra 
charge) or CURRENT EVENTS PAGES to your 
yearbook. Indicate your design and placement 
selections on the Production Form. Stock 
Autograph pages are not included in your total 
page count and are not numbered. Current Events 
pages SHOULD BE INCLUDED in your total page 
count, but will not be numbered. We will still add 
them in for you in the area specified on the 
production form. 

Current Events pages will not be billed 
separately. Yearbook price will be based on 
total page count (including Current Events 
pages).

We cannot process your yearbook without a 
completed PRODUCTION FORM!

FOLLOW THE INSTRUCTIONS in this guide 
carefully. Yearbooks not within our guidelines may 
be returned for rework and will be rescheduled. 
This will delay shipment.

If you have questions, please contact Customer Care 
at 1-800-447-3274. We are happy to help!
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as soon as you start creating your book!

E-mail your PDF test pages to DON’T FORGET!
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Thanks to the acceptance of the PDF format, you can produce your yearbook using one of many programs. All you 
need are the correct settings and a basic understanding of how a PDF is created.  

PDF Plan
PDF stands for Portable Document Format, a technology pioneered by Adobe® for the purpose of creating a 
“common” exchange format for documents between programs and computer platforms. PDF documents can be 
read by nearly all modern computers, (and many mobile tablets & smartphones, too). They do not require the 
original application to be viewed and retain a visual consistency across platforms perfect for publishing your book!

Save money and eliminate problems by submitting yearbook files as PDFs. Programs such as Adobe® InDesign® 
and QuarkXPress® export documents as PDFs easily. You may also use many other programs to create and 
view PDF documents. (We only provide instructions for professional level PDF authoring tools that allow us to 
better control and predict PDF output.)

ACCEPTABLE PROGRAMS  
We offer instructions in this guide that detail the procedures used to create PDF files with the following programs:

•	 Adobe® InDesign® CS3-CS6
•	 Adobe® Photoshop® 
•	 QuarkXPress® 7–9.3.x

If you’re attempting to use older page layout programs, you will need Acrobat Distiller to process your postscript 
files, so the appropriate PDF files can be created. Distiller may also be used to process postscript files created out of 
programs other than those listed above. However, we do not offer assistance for any unlisted programs, and do not 
supply any software (including Distiller). If you have questions about your software and how it creates PDF 
documents, please contact the manufacturer of your software. 

YEARBOOK SETUP
We recommend you use the program templates on the enclosed PDF Creation CD. You can easily create your 
yearbook pages in QuarkXPress, InDesign and Photoshop! Please follow the digital guidelines on the following 
pages. 

CREATING A PDF
You will find PDF CREATION INSTRUCTIONS on pages 10-21; follow these instructions carefully. Important 
settings are included in the enclosed PDF Creation CD. The Color Settings and PDF Job Options files on this CD 
must be installed if you plan to submit PDF files. PDF testing must be done as early as possible and approved 
before your yearbook can be submitted.

Send a PDF test of 2 or 3 pages of your book to: graphics@walterspublishing.com.

OptionsPDF
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Guidelines

Use the PROGRAM TEMPLATES included on the PDF Creation 
CD (Includes QuarkXPress®, InDesign® and Photoshop®). 

8.5 x 11 Book Size Specs: 8.5" x 11" with additional 0.125" (1/8") 
bleed on all 4 sides and in single-page layout mode. Facing pages 
format is allowed only if the book is submitted as a PDF.  
Create PDFs of single pages and test (e-mail us a test file) before 
submitting the files for publishing. E-mail test pages and questions 
to graphics@walterspublishing.com. 

9 x 12 Book Size Specs: 9" x 12" with additional 0.125" (1/8")  
bleed on all 4 sides and in single-page layout mode. Facing pages 
format is allowed only if the book is submitted as a PDF. 
Create PDFs of single pages and test (e-mail us a test file) before 
submitting the files for publishing. E-mail test pages and questions 
to graphics@walterspublishing.com.

BLEED: Artwork, photos or page elements that are to bleed 
(extend to the edge of the page with no margin) must be set up 
0.125" (1/8") beyond page edges on all sides of the page. This 
bleed will be trimmed off. Program templates are preset with a 
bleed box on each page (sized to 8.75" x 11.25" for an 8.5” x 11” 
book). Backgrounds either need to bleed 0.125" (1/8") beyond page 
edges or be within the .5" (1/2") page margin.

PAGE MARGINS: All important text and images, that you
do not want to risk being trimmed off or lost in the binding, should 
be kept within the .5" (1/2") safety margins on the templates. This 
is particularly important for standard hard cover books.

HARD COVER BINDING OPTIONS: There are two types of hard 
cover bindings available. Smyth binding is strongly recommended 
for books that have photos or text that span across two pages or 
that have text and/or images that are less than a 1/4 of an inch from 
the trim line on the interior (gutter) side of the book. Standard 
Hard Cover binding works best when a book has been designed 
with all text and images at least 1/2” from the trim lines. 
 
PDF SIZE and NAMING CONVENTIONS: 
A PDF book may be submitted in whatever section sizes you would 
like (1 page, 4 page, 16 page, entire book). PDF files should be 
named in a manner that clearly indicates the job number and page 
number; e.g., jobnumber_001-016.pdf.

PAGE NUMBERS: Each page in your yearbook must include a 
page number! Page numbers should be included on all PDF files.

SAVING AND NAMING IMAGES: Images should be saved in a 
folder on your computer and names should not be changed 
unless you relink the images after the name change. Renaming 
images or moving them to a different folder or CD could cause 
missing link problems later on when you are exporting your PDF 
files. Image names must be 8 characters or less (excluding 
extension) and each image should have a unique name for linking 
purposes.

PAGE TEMPLATE LIBRARIES are included on the enclosed CD 
for use in QuarkXPress or InDesign. 

FONTS are provided on the Artwork DVD for your unlimited 
use. If you choose to use custom fonts (Option 2), include them  
with your files when the job is submitted; or submit your book as 
PDF files with all fonts embedded. 

To INSTALL STOCK FONTS ON A MAC, copy all fonts from the  
Artwork DVD into your System Fonts folder. Restart your 
computer to activate them. 

To INSTALL STOCK FONTS ON A WINDOWS COMPUTER,  
go to the Start menu, choose Control Panel, and open the font 
folder inside. Install all fonts from the Artwork DVD into the font 
folder by choosing File and Import New Font until all yearbook 
fonts have been loaded.

DO NOT USE FONT MENU STYLES ON A WINDOWS 
COMPUTER. You may bold or italicize a font ONLY if you have the 
bold or italic version of that font.

STOCK ARTWORK is provided on the Artwork DVD on the 
inside back cover of this guide. Backgrounds are provided as .jpg 
files and clip art is provided as .png files. Clip art (.png files) may not 
be compatible with all versions of publishing software. 

TWO-PAGE SPREADS: If you choose to include two-page 
spreads in your book, just create your book as facing pages and 
create single-page PDF files when you export your book. Check your 
PDF files before submitting to make sure that they split correctly and 
that the bleeds extend on all four sides. If you need help with this, 
please contact graphics@walterspublishing.com.

CUSTOM COVERS: A separate CD/DVD/USB Drive containing 
your custom cover should be submitted with the completed 
Custom Cover Form by February 2 for books shipping before 
June 30. For Fall delivery books (delivered by December 31), 
cover files must be submitted by August 1. 
Our custom cover templates must be used for custom cover 
submission (see the Custom Cover Brochure). Templates vary 
according to binding type (soft saddle-stapled, perfect-bound or 
hard cover) and page count. Choose the correct cover template 
based on these criteria.

SEND TEST FILES early in the school year. We can verify that you 
are on the right track with program settings and image resolution. 
E-mail test file to graphics@walterspublishing.com.

Before you begin your yearbook project install all necessary applications. Follow the guidelines listed below, 
then set the application preferences listed on the following pages. These guidelines apply to all books.

Digital
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Requirements
Images are the MOST important part of your yearbook project. The following information will help you get the best results 
from your images, and publish a spectacular-looking yearbook! Be sure to consider the following when choosing images to 
include in your yearbook:

Image

IMAGE COLOR SPACE  No need to alter your image 
color space.  If images are RGB, no CMYK conversion is 
needed. Our PDF output settings and refining process will 
convert them to the proper color space. Most cameras and 
scanners include a source profile (also known as input 
profile) when saved. We recommend you embed (or tag) the 
source profile to each image. A source profile will define how 
the camera/scanner interprets the colors in the photo and 
make your color conversion clean and effortless.

HOW WILL MY IMAGES LOOK ONCE THEY HAVE 
BEEN CONVERTED TO CMYK? Your converted images 
will look very similar to your original RGB files. There is much 
more color information in the RGB color space than can be 
printed with a CMYK profile, but the results have been very 
accurate with the conversion profiles we use. If you are 
concerned about how your images will convert, color testing 
is an option, if requested in advance. 

IMAGE RESOLUTION  Resolution is a very important 
factor to consider when looking at your digital images. 
Resolution is defined in two ways: pixels per inch (ppi) on 
your screen and dots per inch (dpi) on a press. To print an 
image effectively, it needs to have a resolution of 
between 250 and 300 ppi/dpi. The image should be 
the same dimensions that you plan to print it in your 
yearbook at a resolution of 300 dpi.

HOW CAN I CHANGE AN IMAGE’S RESOLUTION?
Many people try to increase resolution (ppi/dpi) using imaging 
software such as Photoshop®; this usually makes the image 
quality worse. There is only a fixed amount of information 
(pixels) in an image, and by increasing the resolution and 
leaving the image size the same, you are asking the software 
to add more pixels to the image. The software is forced to 
“guess” what each added pixel should look like based on the 
other pixels around it, and the image becomes blocky 
or fuzzy. 

If an image didn’t start out with a high resolution 
(250-300 dpi), the only way to increase the resolution 
is to retake the picture at a higher camera setting or 
rescan the image at 300 dpi. This does not apply to digital 
camera images that have been taken at a high-quality 
setting. They will have a low resolution (72 dpi), but the 
image dimensions will be large enough to compensate for 
the resolution. The images actually have the extra pixels 
needed to increase the resolution when the photo 
dimensions are decreased.

DIGITAL IMAGES  Many digital cameras will have a 
resolution of 72 dpi, but the dimensions of the image are 
larger than you need—when you reduce the photo size, the 
resolution increases to 250 to 300 dpi. You may leave digital 
images the size they come off your camera and resize them 
in your layout program.

FILE FORMATS  JPEG (.jpg), TIFF (.tif), PNG (.png) and 
EPS (.eps) are all acceptable file formats to use in your 
yearbook. You choose the format when you save your 
images in the scanning or image editing software. JPEG files 
should be saved at a high-quality setting (less compression 
10–12) and are favored because of their small size. TIFF files 
must be saved with no compression.

IMAGE SCANS  For scanned pictures, the scan resolution 
must be set to at least 300 dpi for a scan at 100%. If you 
will enlarge a photo, increase the resolution of the scan to 
compensate. Review the other scanner options before you 
scan your images.

WEB IMAGES  Images from the Web will have a low 
resolution of 72 dpi and will print poorly. We do not 
recommend their use. In addition, most images found on 
the Internet are copyright protected.

CONCERNS?  If you have concerns about your images, 
contact us at 1-800-447-3274 to discuss possible solutions 
and/or perform image testing. 
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Options
Artwork adds an extra punch to your yearbook. We provide a variety of fun and colorful stock artwork files for your book. 
Choose from backgrounds, borders, autograph pages and clip art. The Artwork DVD is located on the inside back cover of this 
guide. Examples of creating a theme using our art are located on pages 22 and 23 of this guide. Check them out!

Artwork

STOCK ARTWORK
Your yearbook becomes a unique expression when you 
creatively use stock backgrounds, borders, autograph pages 
and clip art. Our stock artwork has been grouped into series 
according to theme, color and style. Use artwork within 
the same series for a consistent looking yearbook. 
When you choose clip art, less can be more—you want 
the focus to be the photographs.

BACKGROUNDS add variety to your pages. All 
backgrounds are set up to bleed (extend) 0.125" (1/8") 
beyond page edges. Use the program templates to place 
them correctly and avoid correction charges. Or use them 
with text as section dividers in your yearbook. We do not 
recommend color backgrounds for use in black and white 
books as they may not convert well.

BORDERS are used to frame pages. Some borders are set 
up to bleed (extend) 0.125" (1/8") beyond page edges. 
Borders that do not bleed will have white edges and should 
be centered on the page. Use program templates to place 
borders correctly and avoid correction charges. Or use them 
with text as section dividers in your yearbook. We do not 
recommend color borders for use in black and white books 
as they may not convert well.

AUTOGRAPH PAGES may be placed in your yearbook 
wherever you would like. Use program templates to place 
pages correctly and avoid correction charges. Color 
autograph pages cannot be used in black and white books.

CLIP ART is used to fill in spaces in place of photos or to 
decorate your pages. Choose from a large variety of clip art! 
Many pieces of clip art coordinate with background sets (see 
the note in the Clip Art section of the Artwork and Font 
Guide).

CUSTOM ARTWORK 
You may choose to include custom artwork in your book. 
Please follow the same guidelines as with stock artwork. Full 
page backgrounds should be saved at 8.75" x 11.25" at 300 
dpi. Bleeds must extend 0.125" (1/8") beyond page edges on 
all sides. We recommend you choose artwork that creates a 
coordinated look throughout your entire yearbook. 
See page 4 for accepted file formats.

COPYRIGHTED MATERIAL
Walter’s Publishing reserves the right to refuse to print 
any materials provided by its customers for any reason, 
including, but not limited to, materials determined by 
Walter’s Publishing, at its discretion, to be offensive, illegal, 
or in violation of any copyright or other proprietary rights. 
By submitting an order, and providing photos, trademarks, 
tradenames, images or other content to Walter’s Publishing 
(collectively, the “Customer Content”), Customer represents 
that it has the right to have the order printed, with the 
inclusion of the Customer Content, and that Walter’s 
Publishing’ printing of the order, and the use of the 
Customer Content, will not infringe the intellectual property 
right of any third party.  Customer will defend, indemnify 
and hold harmless Walter’s Publishing from any claims, costs, 
losses or liability (including reasonable attorney’s fees and 
expenses) arising out of or related to the Customer Content 
or the production of the Order as directed by the Customer.
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Quick Tips
Please follow the instructions on pages 12-13 (Mac InDesign users) or pages 18-19 (Windows InDesign users) for 
installing program preferences, output style and color settings. These settings should be in place before you open 
a new document. Below is a list of quick tips that will help you when creating your yearbook.

InDesign

InDesign
CREATING A NEW INDESIGN DOCUMENT
Under the File menu, choose Document Presets and 
Define. Click on Load. Locate the PDF Creation CD on your 
desktop and Open PROGRAM_TEMPLATES. Open the folder 
called ADOBE_INDESIGN, then choose InDesign_8.5x11_
document.dsct (if printing an 8.5" x 11" book) or 
InDesign_9X12_document.dsct (if printing a 9" x 12" book) 
and click Open, then click OK. Then, under the File menu, 
choose New and Document. Then, where it says Document 
Preset at the top of the window, select whichever preset fits 
the size you opened (either InDesign_8.5x11_document_ 
Preset or InDesign_9x12_document_Preset ) and click OK.

OPENING INDESIGN PAGE TEMPLATE LIBRARIES
Double-click on one of the IND_TEMPLATES in the 
INDESIGN folder (located in the TEMPLATE LIBRARIES folder 
on the PDF Creation CD). A window will automatically open 
up in InDesign. The window will show small versions of the 
wide variety of templates available. Pick which one you want 
to open, click and hold, and drag it to your open page 
document. Line up the small square in the upper left corner of 
the template with the upper left corner of your document.

INDESIGN IMAGE LINKS
To check the image links in your document, select the 
Window menu and choose Links. This will provide you with 
a list of all images used in your document. 

INDESIGN IMAGE PLACEMENT
To place images and stock artwork, choose the Place option 
under the File menu. 

INDESIGN PAGE NUMBERING
To create a Master Page: in the Window pull-down menu, 
select Pages. Click on the triangle in the upper left corner of 
the Pages window. Select New Master. Create a text box on 
your master page. Type a number in the text box, and format 
it to the correct font, point size, color, alignment and location 
on the master page. Highlight the number; in the Type pull-
down menu, select Insert Special Character, then select 
Markers, then select Current Page Number and this will 
automatically number every page that uses that Master Page. 
To number the first page in your document a number other 
than “1”:  select the first page in your document; and go to 
the Pages menu and select Numbering & Section Options, 
choose Start Page Numbering, and type in the page 
number that you want the section to start at. 

PACKAGING INDESIGN DOCUMENTS
Open the document you would like to package; go to the File 
menu, select Package (always make sure that you have saved 
your file before choosing Package). A Package window will 
open. Check to make sure that all of your fonts are loaded 
and that all of your images are linked. If there are no errors, 
click Package. If there are errors, note them and hit Cancel, 
and fix any errors before trying to package again. When the 
Printing Instructions window opens up, click Continue. A 
Create a Package window will open up. Where it says Save 
As, type in the name that you want for the folder. Then select 
Copy Fonts, Copy Linked Graphics, and Update Graphic 
Links in Package and then click Save.

QuarkXPress

®
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Quick Tips
Please follow the instructions on pages 14-15 (Mac QuarkXPress users) or pages 20-21 (Windows QuarkXPress 
users) for installing program preferences, output style and color settings. These settings should be in place before 
you open a new document. Below is a list of quick tips that will help you when creating your yearbook.

QuarkXPress

QUARKXPRESS PREFERENCES MENU
Under Preferences choose General under the Project menu. 
Make sure that Auto Picture Import is set to Off.

Under Preferences select the Tool tab. Select each image and 
text box tool and go to Modify to select defaults for each 
tool. First, turn Runaround to None and then under the Box 
menu, choose None for Image Box Fill Color and None for 
Text Boxes.  

CREATING A NEW QUARKXPRESS DOCUMENT
Use the QuarkXPress template provided on the PDF 
Creation CD. It is a pre-numbered 16-page document with 
margins, page size, bleed box and other elements set up to our 
standards.

QUARKXPRESS PAGE NUMBERING
To number the first page in your document a number other 
than “1”:  select the first page in your document; go to the 
Page menu and select Section. Check the Section Start box 
and type in the desired beginning number.

QUARKXPRESS FONT USAGE
To check font usage in your document, look under the 
Utilities menu, select Usage and choose the Fonts tab. This 
window will provide you with a list of all fonts used in your 
document and the option to replace them. If you need to 
check fonts in the Master Pages, you must first be on one of 
your Master Pages and then check the Utilities menu and 
Usage. Hidden fonts are often found in the Master Pages. Do 
not use font menu styles on a Windows computer. You 
may bold or italicize a font ONLY if you have the bold or italic 
version of that font. You must have the actual version of each 
font that is used in the PDF or it will not embed correctly. 

QUARKXPRESS IMAGE LINKS

Images and stock artwork should be placed in QuarkXPress, 
not copied. To do this, draw an image box or use the preset 
bleed box in the program template, select the File menu and 
choose Get Picture. To check the image links in your 
document, look under the Utilities menu, select Usage and 
choose the Pictures tab. This will provide you with a list of all 
the images used in your document and will allow you to 
update them. If you need to check image links in the Master 
Pages, you must first be on one of your Master Pages, then 
check the Utilities menu and Usage. Images with a solid link 
will display an ”OK” next to the image name.

COLLECTING QUARKXPRESS DOCUMENTS
In order to collect all the fonts and images used in a 
document, you can use the Collect for Output option 
located in the File menu. You may want to purchase a 
program such as FlightCheck® Collect to collect all the files. 
Either of these options will enable you to easily collect and 
send all of the information needed to print your book.

®
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GETTING STARTED
How do we PUT OUR BOOK TOGETHER? Determine 
the approximate number of pages you will need in the 
book, based on the number of students and staff members, 
number of grades, extracurricular activities and other pages 
you might want in the book. If you plan to use portraits 
from your school photographer, contact the photographer  
at the beginning of the school year. Arrange to have your 
portraits available as early as possible, as you will need them 
to begin page layout. 

How do we ORGANIZE OUR YEARBOOK STAFF? 
Assign committees: e.g., coordinator, publicity (advertising 
and sales), photography, design and layout, proofing, 
bookkeeping. 

We suggest the staff include both an adviser and an 
assistant adviser. Please notify us early with contact 
information. Include home phone numbers and e-mail 
addresses to avoid delays. 

Hold a staff meeting at the beginning of the school year to 
set up a schedule for regular staff meetings.

What steps should we take to ASSEMBLE OUR 
BOOK? First, have your photographer supply you with high-
resolution digital files.

Then, follow this guide to create your yearbook. This can be 
done through school curriculum, your parent/teacher 
organization or volunteers. 

Using committees, you can put the book together in stages. 
For example, at the beginning of the school year, put 
together the classroom pages, and then, as each activity, 
event or sporting season concludes, add those pages to  
your book. 

What process do we follow to GET OUR BOOK 
PRINTED? Complete the Yearbook Checklist found on the 
PDF Plan Production Form. Gather all the publication 
materials and send them to us.

COVER SET-UP
May we DESIGN OUR OWN COVER? Yes, but this may 
be an additional charge— contact your sales representative 
for more information. Custom covers have printing on both 
the back and the front covers. Custom covers must be 
submitted with the completed Custom Cover Form by 
February 2 (for yearbooks shipping before June 30). For Fall 
delivery yearbooks (delivered by December 31), cover files 
must be submitted by August 1. Production cannot begin 
unless the Custom Cover Form has been fully completed 
and artwork is acceptable.

May we PRINT ON THE BACK COVER? Yes, only if you 
are creating a custom cover. Stock covers can only be 
imprinted in the logo area on the back.

May we PRINT ON THE INSIDE OF THE COVER? Yes, 
you can print on the inside of soft cover yearbooks, or 
design endsheets for a hard cover yearbook. There is an 
additional charge for this. Contact your yearbook 
representative for more information.

TEMPLATE OPTIONS
Are we required to use the TEMPLATES (provided 
on the PDF Creation CD) and/or ARTWORK 
provided on the Artwork DVD? How many FONTS 
can we use? You may create your own templates and use 
any custom artwork that follows our guidelines. You may 
use any of the fonts provided on the Artwork DVD free of 
charge. PDF books may use an unlimited number of fonts, 
as long as they are embedded correctly (see the PDF 
Creation section of this guide—pages 10–19).

How do we ACCESS THE TEMPLATE LIBRARIES 
provided on the PDF Creation CD?  
In QuarkXPress and InDesign, go to the File menu and 
select Open. Locate the loaded CD and choose the desired 
library. QuarkXPress allows more than one library to be open 
at a time.

May we MODIFY THE TEMPLATES? Yes. You may alter 
them, but keep images and text within the .5" (1/2") page 
margins.

May we SELL AD SPACE to help fund our 
yearbook? Do you have AD TEMPLATES? Yes, you 
can use our templates, which allow from one to eight ads 
per page (see candid template section) or create your own 
ad pages. 

YEARBOOK LAYOUT
Do we NEED TO KNOW A LOT ABOUT COMPUTERS? 
You should be familiar with your hard drive, the programs 
you are using, and how and where to save images.

What PROGRAMS may we use to create our 
yearbook? QuarkXPress® (version 7 or higher), InDesign® 
(CS3 or higher) or Photoshop®. Knowledge of Photoshop is 
required if you plan to scan or resize images. Other 
programs may be used to create PDF files but we support 
only the programs listed above. If you are using another 
program to create your files, please contact our graphics 
department with questions and to submit a test. E-mail 
graphics@walterspublishing.com.

AnswersQuestions &
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How do we BEGIN? Start by reading the entire PDF 
Instruction section in this book. Quark users should set all of 
the preferences as instructed on page 7 of this guide, and 
use one of the program templates included on your PDF 
Creation CD (located on the inside front cover of this guide). 
InDesign users should install the document preset 
(instructions on page 6). Load and activate color profiles and 
PDF export settings for both programs; follow instructions 
for your program, located on pages 10–21.

May we design our yearbook in a FACING PAGES 
LAYOUT? Yes. Make sure the bleeds are extended on all 
four sides. Convert your book to PDF files as single pages, 
and e-mail a PDF test to us before submitting the files for 
publishing. For more information contact  
graphics@walterspublishing.com

May we include a TWO-PAGE CLASS PICTURE 
SPREAD in our book? How do we submit it? Yes, a 
two-page class picture spread can be printed in your 
yearbook. Set it up like any other page in your book that 
bleeds, making sure the images meet correctly in the center 
of the two pages.

How should we SAVE OUR YEARBOOK FILES? 
A PDF book may be submitted in whatever section sizes you 
would like (1 page, 4 page, 16 page, entire book). PDF files 
should be named in a manner that clearly indicates the job 
number and page number; e.g., jobnumber_001-016.pdf.

How do we CREATE A PDF of our yearbook? Install 
the PDF export options from the PDF Creation CD included 
in this guide. Follow the PDF Creation Guide instructions 
that pertain to the programs that you are using to create 
your yearbook.

IS SUPPORT AVAILABLE if we encounter problems 
or have questions? Yes, phone and e-mail support is 
available. We will gladly help you with questions regarding 
preferences, requirements, artwork, templates and image 
quality. Contact graphics@walterspublishing.com. 
However, we offer limited computer support and are 
not staffed to instruct first-time program users. For 
questions about computer programs, it’s best to seek help 
on the Internet or in your program’s user guide.

IMAGE CONCERNS
DO IMAGES NEED TO BE IN CMYK MODE or may 
we submit them in RGB mode? Images can be 
submitted to us in either RGB or CYMK mode. Make sure 
that you attach the input color profile, especially if you 
converted images from RGB to CMYK.

WHAT RESOLUTION should images be? Every image 
should be at least 300 ppi/dpi (pixels per inch/dots per inch) 
at the actual dimensions the image will appear in your 
yearbook. You can check this in Photoshop under “Image” 
and “Image Size.” For more information, see page 4.

May we include PICTURES FROM MAGAZINES, 
MUSIC CD COVERS OR STICKERS in our yearbook? 
No. It is not legal to publish any previously published 
(copyrighted) material unless you have supplied a 
release signed by the copyright owner. Resolving 
possible copyright infringement may result in delaying your 
shipping date; if you’re not certain about an image, call 
Customer Care at 1-800-447-3274 for assistance. See 
copyright information on page 5.

How should IMAGE FILES BE NAMED? Each image, 
whether it’s a student portrait or a candid photo, should 
have a unique name no longer than eight characters (not 
including extension). This is critical, if you are not submitting 
a PDF file, to avoid losing images and linking incorrectly in 
your document. We recommend using a simple formula for 
naming images: use the page number on which the image 
appears, followed by an underscore, followed by position 
number on the page. For example, the three JPEG images to 
be placed on page 18 would be named 018_01.jpg, 
018_02.jpg, 018_03.jpg. Do not use these keystrokes: -,~,/. 

Please Note: this is only if you are submitting a non-
PDF book.

How will we know if OUR IMAGES ARE 
CORRECTLY LINKED? In InDesign®, check image links 
under the Window menu, choose Links, then select Link 
Information. Then check the Content Status.

In QuarkXPress®, under the Utilities menu, choose Usage to 
see  a list of all of the images used in the document. Their 
status should be listed as “OK” under image status. If it says 
“Missing” or “Modified”, you will need to update each 
image before  resaving the document.

AnswersQuestions &
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Pdf CreationMac Settings
The following pages will guide you through loading our output styles and turning on color settings for a Mac. These settings 
will give you the best possible color conversion and will also show you, as closely as possible, what your images will look like 
when printed on a 4-color process printing press.

STEP 1  Insert the PDF Creation Installation CD

Load all applications that you will be using for book and PDF file creation. Confirm that all applications on your computer are 
closed and insert the PDF Creation Installation CD. Manually install settings and set Preferences according to program 
instructions located on the following pages. The files that you need to install these settings are located on the PDF Creation 
CD, in the MAC_Install folder. 

STEP 2  Create PDF Test Files

Using the Program Templates located on the PDF Creation CD, create two or three PDF test pages that include images and 
fonts you plan to use in your book. Place the WP_Color_Target.tif file (from the PDF Creation CD) on one of your test pages 
just like any other image. We also recommend that you set up a test page with a bleed, (background color or image that 
extends 0.125" beyond the document edge) so we can determine if bleeds are set up correctly in your PDF file.

E-mail your test files to graphics@walterspublishing.com as soon as you start creating your book! PDF test files need to 
be submitted at least 4 weeks prior to book submission. PDF test files must be e-mailed one at a time due to large file 
size. If they are too large to email, FTP instructions can be requested by contacting graphics@walterspublishing.com

We will preflight your PDF test files to ensure that page size and bleeds are set up correctly, fonts have been embedded, and 
image resolution is at an acceptable range. If preflight problems are found, you will be notified and your book will be 
placed on hold. This could possibly delay the delivery of your book. 

To avoid this, remember to send in your PDF test!

STEP 3  Design Your Book

Once your PDF tests have been approved, start designing your book. Have fun with it—be creative! When you generate the 
final PDF file(s) of your book, it is very important that you use the same computer and settings you used for testing. If, for 
any reason, the PDF of the final book will be generated from a different computer than the testing, or the applications have 
been reinstalled, you must resubmit PDF test files and get approval a second time to prevent delays once your book has been 
submitted for publishing.

10
as soon as you start creating your book!

E-mail your PDF test pages toDON’T FORGET!
graphics@walterspublishing.com



STEP 4.  WRITE A PDF.
Make sure you have followed all instructions in steps 1–3 
before writing a PDF. 

A.	Flatten your PSD file.

B.	File>>Save As>>Name your file as follows: 
	 jobnumber_001, jobnumber_098, etc. Make sure to 
	 create a folder in a location that will be easy for you 
	 to find later.

C. Under Format, select Photoshop PDF. 
	 Make sure Embed Color Profile is checked.

C. �This warning may appear. Click OK. 

D. �Adobe PDF Preset, select: CG_pdfx4>>Save PDF.

E. �Another warning may appear. Click YES. 

STEP 1.  LOAD COLOR & EXPORT FILES.
Load the following files (located on the PDF_Creation_Install 
CD>>MAC_Install>>ADOBE PHOTOSHOP)  
into the locations listed below.

GRACol2006_Coated1v2.icc place in the following folder: 
Hard drive>>Library>>Application Support>>Adobe>> 
Color>>Profiles Folder.

CG_pdfx4.joboptions place in the following folder: 
Hard drive>>Library>>Application Support>>Adobe>> 
Adobe PDF>>Settings.

CGC_ColorSettings_WP.cfs place in the following folder: 
Hard drive>>Library>>Application Support>>Adobe>> 
Color>>Settings>>Recommended.

STEP 2. TURN ON COLOR SETTINGS.
A. Open Photoshop. Be sure all documents are closed. 

B. Edit>>Color Settings, select CGC_ColorSettings.WP, 
    click OK.

STEP 3.  OPEN PDF TEMPLATE.
The correct template can be found on the PDF Creation CD. 
There is a template for an 8.5"x11" book and a template for a 
9"x12" book. 

Remember to show guides! The outer guides indicate where 
the 1/8" bleed starts and where your book will be trimmed; the 
inner guides show where the “safe” area is. Keep all images 
and text (that you don’t want to be trimmed off or lost in the 
binding) inside this set of margins. Background images should 
go all the way to the edge of the template (bleed) on all four 
sides.

Make sure to save original PSD files with all  
layers included, in case you need to make changes later!

Adobe PhotoshopMac Settings ® ®
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InDesign CS3-CS6 Mac Settings

STEP 1.  LOAD THE OUTPUT STYLE.
Load the following files (located on the PDF_Creation_Install CD>>MAC_Install>>ADOBE INDESIGN)  
into the locations listed below.

GRACol2006_Coated1v2.icc place in the following folder: 
Hard drive>>Library>>Application Support>>Adobe>>Color>>Profiles Folder.

CG_pdfx4.joboptions place in the following folder: 
Hard drive>>Library>>Application Support>>Adobe>>Adobe PDF>>Settings. 
(for CS3 use the file CG_CS3.joboptions instead of CGpdfx4.joboptions) 

CGC_ColorSettings_WP.cfs place in the following folder: 
Hard drive>>Library>>Application Support>>Adobe>>Color>>Settings>>Recommended.

STEP 2. TURN ON COLOR SETTINGS.
A. Open InDesign. Be sure all documents are closed. 

B. Edit>>Color Settings, select CGC_ColorSettings.WP, click OK.

Please Note: Two (RGB & CMYK) warnings may appear when opening files. Click OK, just make sure not to save over the 
original file (if you’re unhappy with the conversion).

®
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STEP 3. WRITING A PDF.
Make sure you have followed all instructions in steps 1 & 2 on the previous page before writing a PDF. 

A. Under File>>Export. 

B. Name your pdf. In CS3-CS4, Select Adobe PDF>>Save.

C. Under Adobe PDF Preset: In CS3 Select CG_CS3>>Export.

13Pdf Creation Guide

In CS5-CS6, you will need to choose Adobe PDF (Print) not 
Adobe PDF (Interactive)>>Save.

In CS4-CS6, Select CG_pdfx4>>Export.



Mac Settings

STEP 4. IMPORT OUTPUT STYLE.
A. Edit>>Output Styles.

B.�	�Import file (located on the PDF_Creation_Install CD>> 
MAC_Install>>QUARK). 
Select file: CG_Quark7_8_Style>>Open.

C. Click Save or the Output will not be saved.

STEP 5. WRITE A PDF.
Make sure you have followed all instructions in steps 1–4 
before writing a PDF. 

A. Under File>>Export>>Layout as a PDF.

B. Name your file using the naming convention: 
jobnumber_001-064 (number of pages in file).   
Click on PDF Style and select CGC_Quark_7_8>>Save.

STEP 1.  LOAD OUTPUT STYLES.
Load the following file (located on the PDF_Creation_Install 
CD>>MAC_Install>>QUARK) into the location  
listed below.

GRACol2006_Coated1v2.icc place in the following folder: 
Hard drive>>Library>>Application Support>>Adobe>> 
Color>>Profiles Folder.

STEP 2. SET PREFERENCES.
A. Open Quark to set Preferences. Be sure all documents 
	 are closed. 

B.	Select QuarkXPress>>Preferences>>Default Print Layout>> 
	 Color Manager. 

C. Set your Preferences to match the screenshot below. Color 	
	 Engine: Automatic; Source Setup: QuarkXPress 7.0 Default; 	
	 check the button next to Enable Access to Picture Profiles;  
	 Proof Output: None; Rendering Indent: Relative Colorimetric.

STEP 3. IMPORT COLOR SETUP.
A. Edit>>Color Setup>>Output.

B. �Import file (located on the PDF_Creation_Install CD>> 
MAC_Install>>QUARK). 
Select file: CG_Quark7_8_Setup>>Open.

C. Click Save or the Setup will not be saved.

QuarkXPress 7-9.3.x ®
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Mac Settings QuarkXPress 7-9.3.x ®

YOU MAY GET THIS ERROR WHEN OPENING A DOCUMENT THAT WAS CREATED PRIOR 
TO LOADING THE NEW SETTINGS:

STEP 1. CLICK LIST PROFILES.
A. Click List Profiles

B. Select the missing RGB profile (if applicable)>>select Replace.

D. Select the missing CMYK profile (if applicable)>>select Replace.
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C. Choose Adobe RGB (1998) and click OK.

E. Choose GRACoL2006_Coated1v2.icc and click OK.



Windows Settings
The following pages will guide you through loading our output styles and turning on color settings for a Windows-based 
computer. These settings will give you the best possible color conversion and will also show you, as closely as possible, what 
your images will look like when printed on a 4-color process printing press.

STEP 1 Insert the PDF Creation Installation CD

Load all applications that you will be using for book and PDF file creation. Confirm that all applications on your computer are 
closed and insert the PDF Creation Installation CD. Manually install settings and set preferences according to program 
instructions located on the following pages. The files that you need to install these settings are located on the PDF Creation 
CD, in the PC_Install folder. 

STEP 2  Create PDF Test Files

Using the Program Templates located on the PDF Creation CD, create two or three PDF test pages that include images and 
fonts you plan to use in your book. Place the WP_Color_Target.tif file (from the PDF Creation CD) on one of your test pages 
just like any other image. We also recommend that you set up a test page with a bleed, (background color or image that 
extends 0.125” beyond the document edge) so we can determine if bleeds are set up correctly in your PDF file.

E-mail your test files to graphics@walterspublishing.com as soon as you start creating your book! PDF test files need to 
be submitted at least 4 weeks prior to book submission. PDF test files must be e-mailed one at a time due to large file 
size. If they are too large to email, FTP instructions can be requested by contacting graphics@walterspublishing.com

We will preflight your PDF test files to ensure that page size and bleeds are set up correctly, fonts have been embedded, and 
image resolution is at an acceptable range. If preflight problems are found, you will be notified and your book will be 
placed on hold. This could possibly delay the delivery of your book.

STEP 3  Design Your Book

Once your PDF tests have been approved, start designing your book. Have fun with it—be creative! When you generate the 
final PDF file(s) of your book, it is very important that you use the same computer and settings you used for testing. If, for 
any reason, the PDF of the final book will be generated from a different computer than the testing, or the applications have 
been reinstalled, you must resubmit PDF test files and get approval a second time to prevent delays once your book has been 
submitted for publishing.
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E-mail your PDF test pages toDON’T FORGET!
graphics@walterspublishing.com



Windows Settings
STEP 1.  INSTALL THE COLOR PROFILE.
A. �Insert the PDF Creation CD. Go to: My Computer>>CD or 

DVD Drive>>PDF_Creation_Install>>PC_Install>> 
ADOBE_PHOTOSHOP pc.

B.	� Right click on the GRACol2006_Coated1v2.icc color 
profile. Choose Install Profile.

Please note: If you are using more than one Adobe program  
to create your files, the color profile needs to be loaded only  
one time.

STEP 2.  LOAD THE COLOR SETTINGS.
A. Open Photoshop. Be sure all documents are closed. 

B.	 From the Edit Menu, choose Color Settings.

C.	In the Color Settings Window, click Load.

D.	�In the Load Window, look in: My Computer>>CD or DVD 
Drive>>PDF_Creation_Install>>PC_Install >> 
ADOBE_PHOTOSHOP pc.

E.	 Highlight CGC_ColorSettings.WP, click Load.

STEP 3. TURN ON COLOR SETTINGS.
A. Edit>>Color Settings, select CGC_ColorSettings.WP, 
	 click OK.

STEP 4.  LOAD THE ADOBE PDF PRESET.
A.	Edit>>Adobe PDF Presets>>Load.

B.	 In the Load Window>>Look in: My Computer>> 
	 CD or DVD Drive>>PDF_Creation_Install>> 
	 PC_Install>>ADOBE_PHOTOSHOP pc.

C.	Highlight CG_pdfx4.joboptions, click Load.

D.	In Adobe PDF Presets Window, click Done.

STEP 5.  OPEN PDF TEMPLATE.
The correct template can be found on the PDF Creation CD. 
There is a template for an 8.5”x11” book and a template for a 
9”x12” book. 

Remember to show guides! The outer guides indicate where 
the 1/8” bleed starts and where your book will be trimmed; the 
inner guides show where the “safe” area is. Keep all images and 
text (that you don’t want to be trimmed off or lost in the binding) 
inside this set of margins. Background images should go all the 
way to the edge of the template (bleed) on all 4 sides.

Make sure to save original PSD files with layers included 
in case you need to make changes later! 

STEP 6.  WRITE A PDF.
Make sure you have followed all instructions in steps 1–5 
before writing a PDF.

A. Flatten your PSD file.

B. File>>Save As>>Name your file as follows: 			 
	 jobnumber_001, jobnumber_098, etc. Make sure to 
	 create a folder in a location that will be easy for you to  
	 find later.

C. �Under Format, select Photoshop PDF. Make sure Embed 
Color Profile is checked.

D. A warning may appear. Click OK. 

E. �Adobe PDF Preset, select: CG_pdfx4>>Save PDF.

F. A warning may appear. Click Yes.
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Windows Settings
STEP 1.  INSTALL THE COLOR PROFILE.
A. Insert the PDF Creation CD. Go to: 
My Computer>>CD or DVD Drive>>PDF_Creation_Install>>PC_Install>>ADOBE_INDESIGN pc.

B.	 Right click on the GRACol2006_Coated1v2.icc color profile. Choose Install Profile.

Please note: If you are using more than one Adobe program to create your files, the color profile needs to be loaded only 
one time.

STEP 2.  LOAD THE COLOR SETTINGS.
A. Open InDesign CS3. Be sure all documents are closed. 

B.	 From the Edit Menu, choose Color Settings.

C.	In the Color Settings Window, click Load.

D.	In the Load Window, go to: 
My Computer>>CD or DVD Drive>>PDF_Creation_Install>>PC_Install>>ADOBE_ INDESIGN pc.

E.	 Highlight CGC_ColorSettings.WP, click Open.

STEP 3. TURN ON COLOR SETTINGS.
A. Edit>>Color Settings, select CGC_ColorSettings.WP, click OK.

Please note: Two (RGB & CMYK) warnings may appear when opening files. Click OK, just make sure not to save over the 
original file (if you’re unhappy with the conversion).
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Windows Settings
STEP 4.  LOAD THE ADOBE PDF PRESET.
A.	File>>Adobe PDF Presets>>Define.

B.	 In Adobe PDF Presets Window, select Load. 

C. In the Load PDF Presets Window, go to: 
	 My Computer>>CD or DVD Drive>>PDF_Creation_Install>>PC_Install>>ADOBE_INDESIGN pc.

C.	Highlight CG_pdfx4, click Open.

D.	In Adobe PDF Presets Window, click Done.

STEP 5. WRITING A PDF.
Make sure you have followed all instructions in steps 1–4 before writing a PDF.

A. Under File>>Export.

B. Name your PDF. In CS3-CS4, Select Adobe PDF>>Save.

C. Under Adobe PDF Preset: In CS3 Select CG_CS3>>Export.
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In CS5-CS6, you will need to choose Adobe PDF (Print) 
not Adobe PDF (Interactive)>>Save.

In CS4-CS6, Select CG_pdfx4>>Export.



Windows Settings
STEP 1.  INSTALL THE COLOR PROFILE.
A. Insert the PDF Creation CD. Go to: My Computer>> 
	 CD or DVD Drive>>PDF_Creation_Install>>PC_Install>> 
	 QUARK pc.

B.	 Right click on the GRACol2006_Coated1v2.icc color profile. 
	 Choose Install Profile.

STEP 2. SET PREFERENCES.
A. Open Quark to set Preferences. Be sure all documents 
	 are closed. 

B. Select Edit>>Preferences>>Default Print Layout>> 
	 Color Manager. 

C. Set your Preferences to match the screenshot below. Color 		
Engine: Automatic; Source Setup: QuarkXPress 7.0 Default; 		
check the button next to Enable Access to Picture Profiles; 		
Proof Output: None; Rendering Indent: Relative Colorimetric.

STEP 3. IMPORT COLOR SETUP.
A. Edit>>Color Setup>>Output.

B. Import Setup file. Go to: My Computer>>CD or DVD Drive>> 
	 PDF_Creation_Install>>PC_Install>>QUARK_ pc.
 
	 You will have to change where it says Files of Type: at the 		
	 bottom of the window to Display All Files in order to view. 
	 Select file: CG_Quark7_8_Setup>>Open.

C. Click Save or the Setup will not be saved.

STEP 4. IMPORT OUTPUT STYLE.
A. Edit>>Output Styles.

B.	Import Style file. Go to: My Computer>> 
	 CD or DVD Drive>>PDF_Creation_Install>> 
	 PC_Install>>QUARK_ pc. 
	 You will have to change where it says Files of Type: at  
	 the bottom of the window to Display All Files in order  
	 to view. Select file: CG_Quark7_8_Style>>Open.

C. Click Save or the Output will not be saved.

STEP 5. WRITE A PDF.
Make sure you have followed all instructions in steps 1–4 
before writing a PDF. 

A. Under File>>Export>>Layout as a PDF.

B. Name your file using the naming convention: 
jobnumber_001-064 (number of pages in file).   
Click on PDF Style and select CGC_Quark_7_8>>Save.
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Windows Settings
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YOU MAY GET THIS ERROR WHEN OPENING A DOCUMENT THAT WAS CREATED PRIOR 
TO LOADING THE NEW SETTINGS:

STEP 1. CLICK LIST PROFILES.
A. Click List Profiles

B. Select the missing RGB profile (if applicable)>>select Replace.

D. Select the missing CMYK profile (if applicable)>>select Replace.

C. Choose Adobe RGB (1998) and click OK.

E. Choose GRACoL2006_Coated1v2.icc and click OK.



Developing a theme for the yearbook is easy and fun when you have great 
options like these. Check out our new themed art sets for 2015 and get 
inspired! Below are just a few of the new and exciting art sets that we have 
included on the Artwork DVD (located on the inside back cover of this guide).

FEATURED:  “IMAGINE” COVER, BACKGROUNDS AND CLIP ART

FEATURED:  “MODERN GEOMETRY” COVER, BACKGROUNDS AND CLIP ART
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Our design team has even pulled together some samples to help you get started creating an amazing yearbook theme. Most 
of the samples coordinate with our new 2014-2015 Stock Cover designs (located on the Stock Cover Guide included in your 
Yearbook Kit). 

FEATURED:  “LINE ART” COVER, BACKGROUNDS AND CLIP ART

FEATURED:  “DIRECTIONAL” COVER, BACKGROUNDS AND CLIP ART
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Submission
Once you have completed the steps to prepare your yearbook pages, submit all of your materials—along with your completed 
Production Form—for printing. Once we receive your book, we will preflight for potential problems. Remember that test 
files should have been submitted immediately after receiving the PDF Creation Guide Instructions.

Yearbook

PRODUCTION FORM
Completely fill out and sign the Production Form. 
We cannot begin processing your book without it! If 
you have copyrighted information in your book, submit 
written verifiable permission for use with your Production 
Form.

SEND IN YOUR BOOK
When your book is collected or PDF is created, save your files 
to the following media: CD, DVD or USB drive.

Items to Send:
A completed Production Form.

The PDF file(s) on CD, DVD or USB drive. A printed 
hard copy should also be submitted with your digital 
files.

Custom covers must be submitted with the completed 
Custom Cover Form by February 2 (for yearbooks 
shipping before June 30). For Fall delivery yearbooks 
(delivered by December 31), cover files must be 
submitted by August 1. 

All PDF books will be screened upon arrival to ensure you 
have followed our guidelines. Any problems and charges will 
be noted and we will contact you to discuss how to resolve 
the problems. We reserve the right to return any PDF job 
which does not follow our specifications. We also reserve 
the right to make any corrections that total $100 or 
less without prior notification.

Please note that in the event a hard copy is submitted 
and there is a discrepancy between the hard copy and 
the PDF, the PDF document will be considered the 
correct version of the document.

BOOK PROOF
You should keep a copy of the digital files you submit. If you 
would like a printed proof, arrange this ahead of time so 
your book can be scheduled accordingly. Proofs are $0.50 
per page (minimum of $25) plus shipping. Receiving a 
printed proof of the book adds 2 weeks to production 
time.

DELIVERY TIME
Please allow 4-6 weeks (4 weeks for soft saddle, 6 weeks for 
soft perfect, standard hard cover and smyth sewn) from the 
date we receive and approve your PDF files and the 
yearbook passes preflight to the date your books are 
shipped. Allow up to 5 business days for delivery. Delivery 
dates are based on reservation or by available dates if no 
advance reservation is in place.

COMPLETED BOOK
We hope you enjoyed the process of creating a yearbook 
with us. It will be a memento of a year to remember…full of 
memories, friends, great times and unforgettable pictures!
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